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I.  Giới thiệu Internet 
 

 

1. Internet 

1.1 Khái niệm/ Thuật ngữ 
 

WWW và Internet khác nhau như thế nào? 
 

WWW chỉ là một phần nhỏ của Internet. Internet bao hàm tất cả phần cứng và phần mềm, bao 

gồm WWW, FTP (File Transfer Protocol, sẽ đề cập đến sau), emails và newgroups. WWW 

chủ yếu xây dựng trên các ký tự và hình ảnh mà các bạn có thể xem bằng các trình duyệt web, 

ví dụ như Microsoft Internet Explorer hoặc Netscape Navigator. 
 

1.2 Tìm hiểu các thuật ngữ HTTP, URL, hyperlink, ISP, FTP 
 

HTTP (HyperText Transfer Protocol) 
 

HTTP là viết tắt của HyperText Transfer Protocol. Đây là ngôn ngữ mà trình duyệt web của 

bạn sử dụng để truy vấn các trang và hình ảnh từ web server. Bạn có thể quan sát những gì mà 

trình duyệt web của bạn đưa ra khi truy nhập vào địa chỉ http://www.yahoo.com 
 

URL (Uniform Resource Locator) 
 

URL (Uniform Resource Locator) là cách gọi khác của địa chỉ web. URL bao gồm tên của 

giao thức (thường là HTTP hoặc FTP), sau đó là địa chỉ của máy tính mà bạn muốn kết nối 

đến, ví dụ về một URL là “http://www.vnn.vn/cntt” sẽ hướng dẫn trình duyệt web của bạn sử 

dụng giao thức giao thức http để kết nối đến máy tính www.vnn.vn, mở tệp web ngầm định 

có tên là default.htm trong thư mục cntt. Tên tệp tin ngầm định không cần gõ vào URL. Khi 

gõ URL cũng có thể bỏ qua tên giao thức http vì trình duyệt lấy giao thức http làm giao thức 

ngầm định. 
 

Siêu liên kết (Hyperlink) 
 

Một siêu liên kết là một phần văn bản (hay hình ảnh) của trang Web, mà khi kích vào đó sẽ tự 

động thực hiện một trong các thao tác sau đây: 

- Đưa bạn đến phần khác của trang 

- Đưa bạn đến một trang web khác trong cùng một Web site 

- Đưa bạn đến một trang web khác trong Web site khác 

- Cho phép bạn download một file 

- Chạy một ứng dụng, trình diễn một đoạn video hoặc âm thanh 
 

Hình ảnh minh hoạ dưới đây là một phần của trang web. Những từ gạch dưới thể hiện các liên 

kết. 

 

http://www.yahoo.com/
http://www.vnn.vn/cntt
http://www.vnn.vn/
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ISP (Internet Service Provider) 
 

Nếu bạn muốn kết nối tới Internet, bạn cần phải đăng ký thuê bao với một nhà cung cấp dịch 

vụ Internet (ISP). ISP sẽ giúp bạn kết nối với Internet thông qua đường dây điện thoại hoặc 

đường dây thuê bao số tốc độ cao. Một trong các ISP nổi tiếng ở Việt Nam là FPT. 
 

 

FTP (File Transfer Protocol) 
 

FTP là cách thức để truyền dữ liệu từ nơi này đến nơi khác qua mạng Internet. Nó thường 

được dùng để download các file có dung lượng lớn từ Internet. Bạn không cần quan tâm cách 

thực hiện của nó mà trong hầu hết các trường hợp, chỉ cần kích vào một liên kết trong một 

trang web thì trình duyệt sẽ thực hiện các thao tác truyền FTP cho bạn. Điều bạn cần quan 

tâm là cần phải download file gì và lưu trữ nó ở đâu. 

Trong nhiều trường hợp, những người viết và bảo trì các trang web sẽ sử dụng chương trình 

FTP để gửi dữ liệu cập nhật các website từ ổ cứng của họ tới máy chủ web server. 

Có nhiều chương trình FTP thông dụng, ví dụ như Cute FTP, bạn có thể tải nó tại 

www.cuteftp.com 
 

1.3 Các khái niệm khác 
 

WebSite là gì 
 

Một website đơn giản là dữ liệu được lưu trữ trên một máy chủ WWW và có thể được truy 

cập từ Internet. Ví dụ, Microsoft có một website riêng của họ mà ở đó bạn có thể download 

các thông tin và phần mềm. Vấn đề là bạn phải biết được địa chỉ website, giống như khi muốn 

gọi điện cho ai đó thì bạn phải biết được số điện thoại của họ. Địa chỉ của một website được 

cho dưới dạng URL. Cấu trúc của URL rất chính xác. Ví dụ, nếu bạn muốn sử dụng trình 

duyệt để viếng thăm trang web của Microsoft bạn phải có địa chỉ URL: 

http://www.microsoft.com 

Do có rất nhiều các công ty hiện có website riêng của họ, bạn có thể sử dụng công cụ tìm 

kiếm mà ở đó bạn có thể gõ vào một từ hay một cụm từ mà bạn muốn tìm, công cụ tìm kiếm 

đó sẽ hiển thị những website có thông tin phù hợp với những gì bạn gõ vào. Tuy nhiên, số 

lượng kết quả tìm được có thể rất lớn. Ví dụ khi bạn gõ “PC courseware” thì sẽ có tới 4,5 triệu 

website bao hàm từ này. 
 

Web Browser - trình duyệt Web 
 

Các trình duyệt web bao gồm có: Internet Explorer và Netscape Navigator/ Communicator. 

Cả hai loại trình duyệt này đều có các phiên bản khác nhau, và các phiên bản mới nhất sẽ có 

nhiều tính năng hơn các phiên bản trước đó. Trình duyệt web cho phép bạn quan sát các trang 

web. 
 

Search Engine- công cụ tìm kiếm 
 

Một công cụ tìm kiếm lưu trữ thông tin về các websites trên Internet bao gồm thông tin về các 

website đã thông báo tới, hoặc các website mà nó tự tìm thấy. Điều quan trọng là các công cụ 

tìm kiếm này không bao gồm thông tin của tất cả các website trên mạng. Có nhiều công cụ 

tìm kiếm của nhiều hãng khác nhau. Với một công cụ tìm kiếm, bạn có thể gõ vào một cụm 

từ, ví dụ ECDL courseware và công cụ tìm kiếm sẽ tìm kiếm trong cơ sở dữ liệu của nó, sau 

http://www.cuteftp.com/
http://www.microsoft.com/
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đó sẽ hiển thị danh sách các website phù hợp với các tham số mà bạn đưa vào. Nhấn chuột 

vào bất cứ một liên kết nào thì bạn sẽ đến được website mà bạn muốn. 
 

Cookie là gì? 
 

Một số website lưu trữ các thông tin của bạn vào trong chính ổ cứng của bạn nhờ cookie. 

Thông tin này được lưu trong các file văn bản nhỏ. Cookie sẽ rất hữu dụng khi một website 

lưu trữ các thông tin cấu hình của bạn để rồi sau này khi bạn quay lại xem các website đó thì 

bạn có thể truy nhập ngay được. Nó cũng giúp cho bạn không phải “log in” lại 
 

Internet cache - bộ nhớ đệm 
 

Mỗi khi bạn hiển thị một website trong trình duyệt web, một bản sao các tệp (cả ký tự và hình 

ảnh) sẽ được lưu trữ trong ổ cứng của bạn để dùng cho việc hiển thị trang Web. Do đó, khi 

bạn quay lại website đó thì các thông tin sẽ được nạp từ ổ cứng và chỉ cập nhật những phần 

thay đổi. Đặc biệt, khi các hình ảnh được lưu trữ trong cache, nếu bạn viếng thăm một site có 

nhiều trang, với logo của công ty trên tất cả các trang đó, khi ấy các trang ấy sẽ tải logo từ ổ 

cứng máy tính, nhanh hơn rất nhiều so với tải từ Internet. 
 

 

1.4 Các vấn đề về bảo mật 
 

Thế nào là một site được bảo vệ? 
 

Một site được bảo vệ là một site chỉ cho phép truy nhập có giới hạn. Trong nhiều trường hợp 

phải thông qua mật khẩu. Nếu bạn không cung cấp password chính xác thì bạn sẽ không thể 

truy nhập được nội dung của site đó. Nhiều công ty có thể sử dụng cách này để cho phép 

thông tin có thể được phân phối rộng rãi. Các ví dụ khác là những site của các công ty thương 

mại muốn bán các thông tin. 
 

 

Chứng nhận số là gì? 
 

Một chứng nhận số được sử dụng để mã hoá các thông tin và truyền đi trên Internet. Một 

chứng nhận số có thể sử dụng để tạo ra một chữ ký số cho một email, chữ ký này đảm bảo 

việc nhận biết người gửi, nó cũng đảm bảo nội dung thư không bị truy cập trong khi nó được 

truyền đi. Chứng nhận số có thể mua tại một tổ chức chứng thực có chức năng ví dụ như 

www.verisign.com, ở đó nó sẽ chứng thực cho bạn. Các chứng nhận số được sử dụng bởi các 

website mua bán hàng trên Internet nhằm mã hoá các thông tin về tài khoản của bạn sao cho 

chúng không bị thâm nhập khi truyền qua mạng Internet. Bạn có thể quan sát chứng nhận số 

cho một trang web bảo mật bằng cách kích vào biểu tượng cái khoá trên thanh trạng thái của 

trình duyệt, ví dụ: http://www.paypal.com 
 

Thế nào là mã hoá? 
 

Mã hoá là cách để che dấu một thông điệp. Nó được sử dụng để tăng cường tính bảo mật cho 

các thông điệp, ở đó chỉ có người được gửi mới có thể đọc được thông điệp đó. Có nhiều cách 

để thực hiện việc mã hoá, cả bằng phần cứng và phần mềm. Một chương trình mã hoá khá nổi 

tiếng là PGP, đây là một phương pháp từng được chính phủ Mỹ sử dụng để ngăn chặn việc 

thất thoát mã nguồn ra khỏi biên giới đất nước. 

http://www.verisign.com/
http://www.paypal.com/
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Có nhiều mức độ mã hóa, các mức độ đó thường được miêu tả bằng số bit sử dụng trong thuật 

toán mã sử dụng. Do vậy, một hệ thống mã hoá 128-bit sẽ bảo mật hơn nhiều so với hệ thống 

mã hoá 32-bit. 
 

Sự nguy hiểm khi duyệt Web 
 

Virus: Việc duyệt web đem lại cho bạn rất nhiều thông tin bổ ích. Tuy vậy, nó cũng làm xuất 

hiện nhiều nguy cơ tiềm ẩn. Nếu bạn download bất cứ một thứ gì từ Web (ngay cả một file tài 

liệu), luôn luôn xuất hiện khả năng file đó đã bị nhiễm một loại virus máy tính nào đó. Để tự 

bảo vệ mình chống lại virus, bạn nên cài đặt một phần mềm chống virus (ví dụ như Norton 

Anti-Virus), và kiểm tra sự lây nhiễm mỗi khi bật máy. Với biện pháp này, những file mà bạn 

download từ Internet mà đã nhiễm virus sẽ bị xoá ngay lập tức. Một điểm quan trọng khác cần 

phải nhớ là phải cập nhật thường xuyên các phần mềm chống virus, để từ đó bạn có thể chống 

được các loại virus mới xuất hiện. 
 

Cảnh giác với khả năng bị lừa gạt khi sử dụng thẻ tín dụng trên Internet 
 

Hết sức cẩn thận khi đưa các thông tin cụ thể về thẻ tín dụng của bạn lên Internet 
 

* Spam thư: Hãy cẩn thận khi gõ địa chỉ email của bạn vào các form đăng ký trong các 

website mà bạn không quen biết. Có thể sau đó bạn sẽ nhận được những lá thư không mời mà 

đến (được gọi là spam) từ những website đó. Tồi tệ hơn, địa chỉ email của bạn có thể sẽ bị 

chuyển đến các công ty chuyên bán các địa chỉ email để quảng cáo, sau đó bạn sẽ liên tục 

nhận được những lá thư spam. 
 

* Sự lừa gạt: Đừng bao giờ chỉ ra các thông tin cụ thể về thẻ tín dụng của bạn cho bất cứ ai 

hay bất cứ công ty nào trừ khi bạn biết rằng bạn đang trao đổi buôn bán với một tổ chức có uy 

tín. Bạn có thể thấy những mặt hàng mà bạn đăng ký không bao giờ được chuyển tới, hoặc tệ 

hơn thẻ tín dụng của bạn sẽ được sử dụng phi pháp để mua bán. 
 

Bức tường lửa là gì? 
 

Bức tường lửa là một hệ thống bao gồm cả phần cứng và phần mềm chống lại sự xâm nhập 

trái phép từ Internet. Trong các công ty lớn, bất cứ một kết nối nào đến Internet đều phải qua 

một hệ thống tường lửa được thiết lập và vận hành bởi đội ngũ các chuyên viên công nghệ 

thông tin. Trong hầu hết các trường hợp, bạn không cần phải quan tâm đến sự tồn tại của hệ 

thống tường lửa đó. Bạn phải quan tâm đến tường lửa là khi bạn truy nhập vào một số site nào 

đó, đôi khi bạn cũng gặp phải vấn đề về tường lửa khi truy nhập đến các site FTP. 
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II.  Thực hành trình duyệt và công cụ tìm kiếm 

 
1. Sử dụng trình duyệt WEB 

1.1 Giới thiệu các trình duyệt WEB thông dụng 
 

Muốn xem và lấy được nội dung trên các trang WEB bạn phải biết cách sử dụng trình duyệt 

Web (Web Browser). Hiện nay có hai trình duyệt Web nổi tiếng và thông dụng: Google 

Chrome của Google, Netscape Navigator của công ty Netcape và Internet Explorer của công ty 

Microsoft. 
 

1.2 Sử dụng chương trình INTERNET EXPLORER  
 

Khởi động và thoát khỏi chương trình Internet Explorer 
 

Khởi động: Kích đúp vào biểu tượng Internet Explorer  trên màn hình hoặc kích vào biểu 

tượng Internet Explorer trên thanh Taskbar. 
 

Thoát khỏi: Kích chuột vào biểu tượng   góc phải trên cùng thanh tiêu đề của trình duyệt. 

Hiển thị/che dấu thanh công cụ 
 

Hiển thị 
 

Bước 1: Vào mục VIEW trên thanh lệnh (menu) chọn chức năng Toolbar. 

Bước 2: Kích chuột vào tên của thanh công cụ cần hiển thị (kết quả là có dấu xuất hiện 

phía trước tên) 

Che dấu 
 

Bước 1: Vào mục VIEW trên thanh lệnh (menu) chọn chức năng Toolbar. 

Bước 2: Kích chuột vào tên của thanh công cụ cần hiển thị (kết quả là có dấu biến mất) 

Sử dụng ô đăng nhập địa chỉ Web trên thanh công cụ 
 

Để truy nhập đến một địa chỉ (URL – Uniform Resourse Locater) trên Internet ta gõ địa chỉ 

vào ô đăng nhập 
 

 

ô nhập địa chỉ 
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Chỉnh phông chữ để hiện đúng nội dung trang Web tiếng Việt 
 

Nhấn chọn thực đơn View. Di chuyển trỏ chuột đến mục Encoding, chọn Unicode (UTF-8) để 

xem các trang nội dung theo bảng mã Unicode, hoặc chọn User Defined để trình duyệt tự thể 

hiện nội dung theo phông chữ đã chọn cho trình duyệt. 
 

 
 

Mở các trang Web theo các mối liên kết 
 

Sau khi mở trang Web, di chuyển đến các nội dung trên trang. Những vị trí nội dung có dấu 

con trỏ chuột đổi hình dáng (ví dụ từ dấu mũi tên thành bàn tay) thì nhấn chuột để mở trang 

Web đã được gán liên kết. Ví dụ nhấn chọn mục Weblinks trên trang VNN. 
 

 
 

Mở thêm cửa sổ duyệt WEB 
 

Bước 1: Nhấn chọn thực đơn FILE trên thanh lệnh. 

Bước 2: Chọn mục New --> Window 

Ví dụ: Có thể thực hành mở các cửa sổ duyệt WEB với các địa chỉ sau: 
 

+ WWW.VNN.VN 
 

+ WWW.FPT.VN 
 

Lưu ý: 
 

Anh/chị có thể sử dụng ngay tổ hợp phím nóng CTRL-N 
 

Hãy thu nhỏ cửa sổ duyệt WEB để kiểm tra thao tác đã làm. 

http://www.vnn.vn/
http://www.fpt.vn/
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Trên các trang Web đã mở, muốn mở các cửa sổ mới, độc lập với trang hiện hành: 
 

Bước 1: Kích chuột phải vào mục liên kết, xuất hiện hộp lựa chọn 

Bước 2: Trên hộp lựa chọn, chọn mục Open in New Window 

 
 

Sử dụng các nút chức năng Back, Forward, Stop, Refresh 
 

Back : quay trở lại trang Web trước đó. 
 

Forward : tiến về trang Web tiếp theo. 
 

Stop : dừng việc tải nội dung trang Web lại. 
 

Refresh : tải lại nội dung trang Web. 
 

Thao tác nhanh đối với việc mở trang WEB 
 

Chức năng của nút HOME: 
 

Khi đang ở trong một trang Web bất kỳ muốn quay trở lại một trang bạn yêu thích nhất (gọi là 

trang HOME) chỉ bằng cách đơn giản là kích chọn vào nút Home trên thanh công cụ. 

Cách thực hiện đặt trang Home với Internet Explorer  

Bước 1: Truy cập vào trang Web chọn là Home page. 

Bước 2: Trên thanh Menu, kích chuột vào mục Tool, sau đó chọn Internet Options. 

Bước 3: Chọn trang General. Trong hộp Home page, chọn nút Use Current. 

Hoặc 
 

Bước 1: Trên thanh Menu, kích chuột vào mục Tool, sau đó chọn Internet Options. 

Bước 2: Chọn trang General. Trong hộp Home page, gõ địa chỉ đã chọn. 

Muốn trang HOME là trang trắng thì đơn giản là xoá bỏ địa chỉ đang có tại hộp Home page. 
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Bổ sung địa chỉ vào sổ các địa chỉ ưa thích (favorite pages): 
 

Với Internet Explorer 
 

Khi đang ở trang Web có nội dung hay mà bạn muốn ghi dòng địa chỉ vào sổ thì các bước cần 

làm như sau: 

Bước 1: Trên thanh công cụ Standard Buttons, nhấn nút Favorites, Sau đó nhấn chọn mục 

Add (hoặc trên thanh thực đơn Favorite, chọn mục Add to ...) 

Bước 2: Trong hộp thoại hiện ra hãy gõ tên mô tả trang WEB vào ô Name. 
 

 

Để tổ chức sổ địa chỉ, nhấn mục Creat in để mở rộng hộp thoại 
 

 
 

Nhấn nút New Folder nếu muốn tạo thêm thư mục mới trong thư mục Favorites, ví dụ thư 

mục trangthethao trong hình minh họa. 
 

Muốn lưu địa chỉ trang Web vào thư mục nào thì đầu tiên là nhấn chọn tên thư mục và sau đó 

nhấn chọn nút OK. 
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Sử dụng thanh địa chỉ để chọn nhanh các địa chỉ đã sử dụng: 
 

Chọn mũi tên bên phải ô nhập địa chỉ làm xuất hiện danh sách địa chỉ. Di chuyển con trỏ 

chuột đến địa chỉ đã có và nhấn chuột. 
 

 
 

Sử dụng thanh công cụ LINK 
 

Nếu thanh công cụ LINK chưa xuất hiện thì bạn hãy vào mục VIEW, chọn chức năng 

TOOLBARS và chọn LINKS. 

Bạn có thể xoá mục liên kết địa chỉ đã có trên thanh này hoặc có thể thêm các địa chỉ liên kết 

bằng cách kéo địa chỉ từ các nơi như: thanh địa chỉ, sổ địa chỉ các trang WEB yêu thích hay 

các địa chỉ xuất hiện trên trang WEB đang duyệt,... 
 

Sử dụng TEMPORARY INTERNET FILES 
 

Trình duyệt WEB sử dụng một không gian đĩa gọi là TEMPORARY INTERNET FILES để 

lưu các trang WEB trước khi thể hiện các trang đó trên màn hình. 
 

Có thể xem lại các trang Web đã duyệt qua, chọn nút HISTORY trên thanh công cụ 

STANDARD BUTTONS, sau đó chọn các trang WEB đã xem trong vùng nội dung bên trái 

có tên là History. Đóng vùng bên trái bằng cách nhấn nút Close ngay trên thanh ngang có 

dòng chữ History. 
 

 
 

Muốn xoá bỏ tất cả nội dung lưu trong thư mục TEMPORARY, hãy làm các bước sau: 
 

Bước 1: Nhấn chọn thực đơn Tool, sau đó chọn Internet Options. 

Bước 2: Chọn mục DELETE FILES, sau đó chọn nút OK. 
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Đặt thông số không hiển thị hoặc hiển thị các hình ảnh 
 

Chúng ta có thể đặt thông số không cho các hình ảnh hiển thị trên trang Web để làm tăng tốc 

độ lấy các trang Web trên Internet về máy cá nhân bằng cách: 
 

Nhấn chọn thực đơn Tools, chọn mục Internet Options làm xuất hiện hộp thoại Internet 

Options. Trong hộp thoại chọn thẻ Advanced và di chuyển đến ô chọn Show Pictures. Nhấn 

chọn ô này nếu muốn lấy hình ảnh về máy và hiển thị, nếu không thì xóa chọn. 
 

 
 

 

 

In nội dung một trang WEB ra máy in 

Bạn có thể in nội dung một trang Web ra máy in một cách dễ dàng như sau: 

Bước 1: Mở trang mà bạn muốn in. 

Bước 2: Chọn mục FILE --> Print ...--> chọn tham số cho máy in và cuối cùng là nhấn nút 

PRINT. 
 

Sao lưu một trang WEB trên máy tính cá nhân 
 

Để lưu một trang Web bạn thích trên Internet vào máy của bạn, bạn cần một số hiểu biết nhất 

định về cấu trúc của trang Web. Đôi khi ngay cả những người có kinh nghiệm thì việc này 

cũng khá khó khăn, do đó ở đây chúng tôi chỉ đưa ra một số hướng dẫn sơ lược để lưu các 

trang Web. Bạn hãy thực hiện theo các bước sau: 
 

Bước 1: Mở trang WEB mà bạn yêu thích 

Bước 2: Vào menu File, chọn Save as... 

Một hộp thoại hiện ra như sau: 
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Bước 3: Chọn thư mục bạn muốn lưu trang Web. Trong hộp File name, đưa vào tên file bạn 

muốn ghi xuống đĩa và chọn "Save as type" là "WebPage, complete" 

Bước 4: Nhấn nút Save 
 

Sao chép các đoạn văn bản trên WEB vào trang văn bản 
 

Các bạn sẽ gặp được những nội dung hấp dẫn, cần thiết cho công việc của bạn và bạn cần sao 

chép các văn bản từ trên các trang WEB vào trang văn bản. Ví dụ bạn muốn làm một bộ sưu 

tầm các bài thơ hay, các bài hát hay mà nội dung bạn thấy được trên các trang WEB. Cách 

làm như sau: 
 

Bước 1: Mở trang WEB có nội dung yêu thích 

Bước 2: Bôi đen văn bản mà bạn muốn sao chép. Thao tác như bạn làm trên các chương trình 

soạn thảo văn bản thông thường 
 

 

bấm chọn 

nơi lưu tệp 

bấm tạo thư 

mục mới 
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Bước 3: Chọn mục EDIT --> COPY hay dùng tổ hợp phím CTRL - C 

Bước 4: Mở trang văn bản bằng chương trình WORDPAD 

Bước 5: Vào mục EDIT --> chọn PASTE hay dùng tổ hợp phím CTRL-V 
 

Sao chép các hình ảnh trên WEB vào máy tính cá nhân 
 

Bước 1: Mở trang WEB có nội dung yêu thích 

Bước 2: Kích phím chuột phải vào hình ảnh mà bạn muốn sao chép. 
 

 

Bước 3: Chọn mục Save Picture As... 

Bước 4: Lựa chọn nơi lưu tệp. Các hình ảnh lấy từ trang WEB không phải là hình ảnh miễn 

phí nên không được làm tư liệu để xuất bản sách nếu chưa được sự đồng ý của tác giả. 
 

Sử dụng chức năng download tệp 
 

Một số trang WEB có những thông tin miễn phí cho phép các bạn sao chép lên máy của bạn 

để dùng. Bạn có thể tập sử dụng chức năng này với việc sao chép tập tin kiểm tra VIRUS 

được cung cấp miễn phí tại địa chỉ: http://WWW.BKAV.COM.VN 

http://www.bkav.com.vn/
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2. Tìm kiếm thông tin trên INTERNET 

2.1 Tìm kiếm theo các trang liên kết 
 

Nhấn chọn mục Weblinks trên trang Web có địa chỉ www.vnn.vn làm xuất hiện trang Web 

địa chỉ liên kết: 
 

 
 

Trên trang Web, các địa chỉ được sắp xếp theo các chủ đề giúp người sử dụng dễ dàng chọn 

lựa các địa chỉ. Sau khi chọn được địa chỉ, người sử dụng chỉ cần bấm chọn địa chỉ để mở 

trang Web. 
 

2.2 Tìm kiếm theo câu điều kiện 
 

Việc tìm kiếm thông tin bất kỳ trên Internet là nhu cầu không thể thiếu đối với kho tàng thông 

tin vô cùng rộng lớn của Internet. Ngoài việc tìm kiếm theo các trang địa chỉ có sẵn, chúng ta 

có nhu cầu tìm kiếm theo các cụm từ mà chúng ta nghĩ ra, ví dụ chúng ta muốn tìm các trang 

Web có chứa nội dung về nấm linh chi. Rất may mắn là trên Internet có các trang Web miễn 

phí cung cấp chức năng tìm kiếm địa chỉ trang Web theo câu điều kiện 

http://www.vnn.vn/
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Cách sử dụng 
 

Gõ một trong những địa chỉ có tiện ích tìm kiếm thông tin miễn phí vào ô địa chỉ của trình 

duyệt Web 

 
Ví dụ:   

 

Để tìm kiếm các trang WEB, chúng ta cần phải cung cấp câu điều kiện. Câu điều kiện có thể 

là một từ hoặc một cụm từ đặc trưng nhất thể hiện chủ đề thông tin mà chúng ta muốn tìm 

kiếm. Chúng ta nên nhập câu điều kiện một cách chính xác và không nên sử dụng những từ có 

nội dung chung chung như: máy tính, mua hàng,.. vì như thế thì kết quả tìm kiếm là vô số địa 

chỉ trang WEB làm cho chúng ta khó chọn được ngay địa chỉ liên kết đến nội dung cần thiết. 
 

Kết quả tìm kiếm xuất hiện ở dạng trang Web nhưng đặc biệt là trang Web này chứa những 

dòng địa chỉ liên kết đến những trang Web khác có chứa các từ tìm kiếm. Người sử dụng chỉ 

cần nhấp chuột vào địa chỉ liên kết để mở trang Web và đọc thông tin. 
 

Các bước thực hiện: 
 

Bước 1: Gõ câu điều kiện vào ô tìm kiếm. Ví dụ: nấm linh chi 

Bước 2: Kích chọn nút Search để bắt đầu tìm kiếm. 

Bước 3: Nhấp chuột vào một dòng địa chỉ liên kết để mở trang Web có nội dung nói về nấm 

linh chi. 
 

2.3 Địa chỉ SEARCH.NETNAM.VN với chức năng tìm kiếm thông tin 
 

Gõ địa chỉ HTTP:// SEARCH.NETNAM.VN vào ô địa chỉ của trình duyệt để mở trang đầu 

tiên như hình dưới đây 
 

 
 

Cách sử dụng: 
 

 Gõ câu điều kiện tìm kiếm gồm một từ hoặc một cụm từ vào ô tìm kiếm 

 Nhấp chuột vào nút SEARCH hoặc đơn giản gõ phím ENTER để bắt đầu quá trình 

tìm kiếm 

nút SEARCH 

gõ   câu   điều   kiện 

vào ô tìm kiếm chọn chế độ tìm

kiếm nâng cao 

mở phần hướng dẫn 

sử dụng tiện ích tìm

kiếm 

chọn chuẩn tiếng 

Việt 
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Chọn chuẩn tiếng Việt 
 

Trên trang Web, người sử dụng có thể chọn chuẩn tiếng Việt là TCVN, UNICODE hay 

VNI. Chuẩn được chọn cho bộ tìm kiếm phải phù hợp với chuẩn được chọn sử dụng trên bộ 

gõ (ví dụ nếu bạn chọn chuẩn TCVN trên bộ tìm kiếm thì trên bộ gõ Vietkey2000 đang sử 

dụng cũng phải đặt chuẩn TCVN3). Nếu người sử dụng chọn đúng thì chữ tiếng Việt được thể 

hiện đúng trong ô tìm kiếm. 
 

 
 

Sử dụng bảng trợ giúp 
 

Bấm chọn mục TRỢ GIÚP trên trang Web chủ, trang Web hướng dẫn xuất hiện. 
 

 
 

Một số trợ giúp 
 

1. Thế nào là một từ? 
 

Một từ là sự kết hợp giữa các chữ cái với nhau hoặc các số với nhau. Chương trình tìm kiếm 

phân biệt các từ theo kí tự khoảng trống (tạo bằng phím SpaceBar) hoặc kí tự cách (tạo bằng 

phím Tab). Ví dụ tạo câu điều kiện có ba từ tìm kiếm như hình dưới 

chọn chuẩn tiếng 

Việt 
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2. Thế nào là một cụm từ? 
 

Các từ được nối với nhau thành một cụm từ khi chúng được đặt trong cặp dấu ngoặc kép (ví 

dụ tạo cụm từ "hội nhập AFTA"), hay sử dụng dấu gạch ngang (ví dụ tạo cụm từ hội-nhập- 

AFTA), hay sử dụng dấu gạch chéo (ví dụ tạo cụm từ 20/11/2000), hay sử dụng một số kí 

hiệu đặc biệt khác. Cụm từ đảm bảo rằng máy tìm kiếm sẽ tìm chính xác theo câu được nhập 

(đúng vị trí, thứ tự, không có từ chen giữa...), chứ không phải là tìm riêng từng từ một. 
 

3. Khoảng trống trong câu điều kiện 
 

Trong câu điều kiện được nhập thì số kí tự trống giữa các từ không làm thay đổi kết quả tìm 

kiếm. 
 

4. Chữ thường và chữ hoa 
 

Khi gõ vào ô tìm kiếm một câu điều kiện bằng chữ thường thì hệ thống tìm kiếm của Netnam 

sẽ tìm ra số trang tài liệu có chứa các từ tìm kiếm dưới dạng cả chữ thường lẫn chữ hoa. 
 

5. Cách thức sắp xếp các địa chỉ liên kết trong trang Web kết quả 
 

Người sử dụng lần đầu tiên sử dụng hệ thống tìm kiếm có cảm giác lo ngại khi kết quả tìm 

kiếm là trang Web chứa quá nhiều địa chỉ liên kết. Vậy thông tin về cách sắp xếp kết quả là 

điều cần thiết giúp cho người sử dụng nâng cao kỹ năng sử dụng. 
 

Hệ thống tìm kiếm của Netnam sắp xếp kết quả tìm kiếm theo tiêu chí sau: 
 

 Các từ hoặc các cụm từ xuất hiện ngay trong vài dòng đầu tiên của tài liệu (ví dụ 

ngay trong tiêu đề của một trang web). 
 

 Thông thường tài liệu nào đáp ứng phần lớn các từ hoặc cụm từ cần tìm thì sẽ đứng 

ở vị trí cao hơn. Chẳng hạn, gõ vào ô tìm kiếm 3 từ, thì tài liệu nào chỉ đáp ứng 

được 2 trong số 3 từ đó sẽ đứng sau vị trí tài liệu có chứa cả 3 từ, và tài liệu nào 

chứa số từ đó xuất hiện nhiều lần hơn lại đứng cao hơn. 
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Sử dụng công cụ tìm kiếm nâng cao 
 

Tìm kiếm nâng cao cũng hoạt động giống như tìm kiếm thông thường nhưng có hỗ trợ người 

sử dụng bổ sung điều kiện tìm kiếm theo cách thức chọn lựa trên danh mục. 
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2.4 Địa chỉ WWW.GOOGLE.COM với chức năng tìm kiếm thông tin 
 

Gõ địa chỉ HTTP:// WWW.GOOGLE.COM vào ô địa chỉ của trình duyệt Web để xuất hiện 

giao diện trang chủ như hình dưới 
 

 

 

 

 
 

 

 

 

 

Mục (1): ô tìm kiếm, nơi cho phép nhập câu điều kiện 

Mục (2): nút khởi động việc tìm kiếm 

Mục (3): nút khởi động việc tìm kiếm và mở ngay địa chỉ Web đầu tiên trong danh sách các 

địa chỉ Web tìm thấy 

Mục (4): chức năng hỗ trợ cho việc chọn ngôn ngữ của trang Web tìm kiếm, quốc gia xuất 

bản trang Web, ... 

Mục (5): tạo giao diện riêng cho người dùng, trong đó có hỗ trợ chọn trang giao diện tiếng 

Việt 

Mục (6): chức năng tìm kiếm nâng cao 

Mục (7): chọn lựa tìm kiếm theo trang Web, ảnh số, các nhóm thảo luận hay theo chủ đề. 

(7) 

(6) 

(5) 

(1) (2) (3) (4) 

http://www.google.com/
http://www.google.com/
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Tạo giao diện riêng 
 

Nếu là lần đầu tiên sử dụng trang tìm kiếm của GOOGLE, hãy chọn mục PREFERENCES để 

đặt giao diện riêng. Chỉ cần chọn các mục như hình vẽ dưới và nhấp chọn nút " Save 

Preferences" để lưu các chọn lựa. 
 

 
 

 
 

Sau khi tạo thành công giao diện, người sử dụng có được giao diện tiếng Việt để dễ sử dụng 

như hình dưới 
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vietnam với vietnam +culture 

HoChiMinh với HoChiMinh -city 

Cú pháp tìm kiếm nâng cao 
 

Sử dụng cách thức ghép thêm toán tử dấu cộng (+) vào một từ sẽ cho kết quả là từ đó phải 

xuất hiện trong kết quả tìm kiếm: 
 

Hãy so sánh kết quả tìm kiếm khi gõ các câu điều kiện: 
 

(lưu ý dấu cộng đi liền với từ culture) 
 

Ghép thêm toán tử dấu trừ (-) vào trước một từ sẽ cho kết quả là từ đó cấm không được xuất 

hiện trong kết quả tìm kiếm 
 

Hãy so sánh kết quả tìm kiếm khi gõ các câu điều kiện: 
 

(lưu ý dấu trừ đi liền với từ city) 
 

Dùng dấu ngoặc kép trước và sau cụm từ cần tìm để tìm ra các trang Web có chứa các từ đó 

theo đúng thứ tự gõ vào. 
 

Hãy so sánh kết quả tìm kiếm khi gõ các câu điều kiện: 

 

 
 

Sử dụng chức năng tìm kiếm nâng cao 
 

Chọn mục Advanced Search trong trang chủ để sử dụng trang tìm kiếm nâng cao như hình 

vẽ dưới đây 
 

 
 

Với trang tìm kiếm tiến bộ, người dùng dễ dàng thu hẹp phạm vi tìm kiếm làm cho bộ tìm 

kiếm cho kết quả nhanh và đúng với mong muốn của người dùng hơn. Sử dụng mục ngày 

tháng, người dùng có thể đặt điều kiện để những trang Web kết quả chỉ là những trang mới 

xuất bản trong 6 tháng gần đây. 
 

Kết hợp giữa tìm kiếm theo cầu điều kiện và theo chủ đề 
 

Như đã trình bày trong phần tổng quan tìm kiếm, người sử dụng có thể tìm kiếm một nội dung 

nào đó theo cây thư mục của bộ tìm kiếm. Nếu người dùng muốn tìm kiếm các phần mềm 

GAMES miễn phí thì việc đơn giản và nhanh nhất là tìm đến chủ đề 

Computer>Software>Freeware>Games. 

vietnamese culture với “vietnamese culture” 
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Cách thực hiện: 
 

 
 

Chọn chủ đề bạn muốn lấy nội dung cho đến khi bạn thấy địa chỉ trang Web liên kết xuất hiện 

ở phần WEB page 
 

 
 

Người sử dụng có thể kết hợp giữa tìm kiếm theo câu điều kiện và theo chủ đề. Đầu tiên gõ 

câu điều kiện vào ô tìm kiếm để xuất hiện trang Web kết quả. Trong trang Web kết quả chọn 

chủ đề được ghi kèm theo. Hãy xem trang minh họa sau đây 
 

 
 

Nhấp chuột vào liên kết chủ đề Computer>Software>Freeware>Games để mở trang chủ đề 

trên trang

chủ nhấp 

chuột vào

mục chủ 

đề 

nhấp chuột vào đây để mở trang

Web có nội dung cần tìm 
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Bạn có thể chọn thêm chủ đề con, ví dụ chọn mục Sports để có những trò chơi thể thao như đá 

bóng, đua ngựa, ...Cuối cùng là mở trang Web để lấy nội dung. 
 

Tìm nối trong kết quả tìm kiếm đã có 
 

Bộ tìm kiếm GOOGLE cung cấp chức năng cho phép tìm nối tiếp trên kết quả đã có. Chức 

năng này cho phép người dùng không cần nhập câu điều kiện quá dài ngay từ ban đầu. Ví dụ 

minh hoạ 
 

 

 

 
 

Tìm kiếm hình ảnh 
 

 
Nhấn chọn mục Hình ảnh và gõ từ khóa tìm kiếm vào ô nhập để tìm được các hình ảnh. Các 

hình ảnh sau khi tìm thấy có thể lấy về máy cá nhân theo cách đã trình bày ở phần trên. 

bấm chọn để tìm tiếp nối 

gõ thêm câu điều kiện vào đây 
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III.  Giới thiệu thư điện tử -Email 

 
1. Các mô hình thư điện tử 

1.1 Mô hình thông điệp trực tiếp 
 

Theo mô hình này, các thông điệp được gửi trực tiếp giữa các máy đang hoạt động trên một 

LAN. Nhược điểm của mô hình này là nếu máy nhận không kết nối vào mạng tại thời điểm 

thông điệp được gửi thì thông điệp bị mất, không thể tạo giao tiếp trong môi trường quốc tế 

khi máy gửi và máy nhận khác nhau về múi giờ. 
 

1.2 Mô hình hộp thư lưu 
 

Trong mô hình này có 1 máy tính chịu trách nhiệm nhận thư và phát thư gọi là máy phục vụ 

thư. Máy phục vụ thư có thể phải hoạt động 24/24 để nhận thư từ các máy gửi đi và sau đó 

phát thư cho các máy khác. Mô hình này khắc phục được nhược điểm của mô hình thông điệp 

trực tiếp khi tổ chức giao tiếp trong môi trường quốc tế. 
 

Mô hình hộp thư lưu xây dựng theo mô hình chung đó là mô hình client/server (khách hàng/ 

người phục vụ), theo đó chương trình thực hiện dịch vụ gồm hai phần: 
 

* Chương trình "server" chạy trên máy phục vụ, thu nhận các thư gửi từ các máy trạm và lưu 

trữ vào các hộp thư lưu. Chương trình này cũng có thể phát tín hiệu báo có thư mới đến cho 

người dùng đang làm việc trên mạng. 

* Chương trình "client" chạy trên các máy của người dùng cho phép soạn thư/gửi thư, nhận 

thư/đọc thư. 
 

1.3 Mô hình thư điện tử qua Internet 
 

Khi các máy phục vụ thư kết nối với nhau qua Internet để tự động trao đổi thư với nhau chúng 

ta có được mô hình thư điện tử qua Internet. Đây là mô hình thực tế được máy tính hóa một 

cách đầy đủ nhất. Trong thực tế những gì chúng ta phải làm để gửi thư đi thì chúng ta cũng 

làm đúng như thế trong hệ thống thư điện tử. Chỉ có điều khác biệt lớn nhất là các thao tác 

đều được máy tính hóa. Ví dụ chúng ta phải nhập/gửi thư bằng máy tính và nhận thư/đọc thư 

bằng máy tính. 
 

2. Địa chỉ thư điện tử 

2.1 Cấu trúc của một địa chỉ 

 Một địa chỉ email điển hình: thanhnt@hn.vnn.vn 

 Phần đầu tiên của địa chỉ là ‘thanhnt’ là tên đăng ký của người nhận thư 

 Phần thứ hai của địa chỉ email là ‘hn.vnn.vn’ là tên miền hay là địa chỉ của máy phục 

vụ thư. 
 

2.2 Ưu điểm của hệ thống email 
 

 Tốc độ cao: Một trong những ưu điểm lớn nhất của Email là bạn có thể gửi các thông 

điệp và tệp đính kèm tới bất cứ người nào trên thế giới, ngay lập tức. 

mailto:thanhnt@hn.vnn.vn
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 Giá thành thấp: Giá thành của việc gửi thông tin nhờ Email chỉ bằng một phần trăm so 

với gửi bằng các hệ thống mail thông thường, đặc biệt khi bạn gửi thư đến một quốc 

gia khác. 

 Xóa mờ không gian và thời gian: Một khi bạn đã thiết lập được một địa chỉ Email, bạn 

có thể truy cập địa chỉ đó từ bất cứ nơi nào trên toàn thế giới miễn là bạn có kết nối 

Internet và ngay cả trong những ngày nghỉ bạn vẫn có thể gửi thư. 
 

2.3 Một số nghi thức khi viết thư điện tử 
 

 Sử dụng các tiêu đề ngắn gọn, chính xác: Trong tình huống một công ty bận rộn, một 

người có thể nhận được nhiều thư trong một ngày. Trước khi mở một thư, chỉ dẫn duy 

nhất về thông tin của thư đó là dòng tiêu đề. 

 Nên tránh sử dụng tất cả các chữ hoa trong một bức thư: Việc sử dụng chữ hoa trong 

một bức thư giống như việc hét toáng lên nơi công cộng. Việc sử dụng toàn chữ hoa 

trong một bức thư sẽ làm cho nội dung trở lên khó đọc. 

 Ngắn gọn: Mọi người có xu hướng đọc lướt qua các thư. Nếu các nội dung quá dài thì 

người nhận có thể sẽ bỏ qua những thông tin quan trọng ẩn chứa trong các thư. 

 Đừng “nổi nóng”: Nếu một người nào đó gửi cho bạn một nội dung không đúng thì 

bạn đừng trả lời lại. Đừng bao giờ trả lời những thư không mong muốn, nếu không 

bạn sẽ nhận được nhiều thư rác trong hộp thư của mình. 
 

2.4 Các vấn đề về bảo mật 
 

Cảnh giác với khả năng nhận phải các spam mail (dạng thư quảng cáo) 
 

Spam mail: Có nhiều công ty bán danh sách địa chỉ email với giá hàng triệu đôla. Ngày càng 

có nhiều công ty mua các địa chỉ email để thực hiện các chiến dịch quảng cáo. Bạn sẽ nhận 

được các spam mail chào mời bạn mua các sản phẩm và dịch vụ của họ. Ở nhiều nước việc 

gửi các spam mail là vi phạm pháp luật. 
 

Cẩn thận với những lá thư lạ 
 

Lây truyền Vi-rút: Cẩn thận khi mở những tệp đính kèm với thư vì chúng có thể mang theo 

vi-rút. 
 

 

Tìm hiểu về chữ ký số 
 

Chữ ký số là mã được gắn kèm vào một email để xác định người gửi. Giống như chữ ký tay 

thông thường, tác dụng của chữ ký số là để đảm bảo rằng lá thư được gửi đến đúng người 

nhận. Các chữ ký số sử dụng thuật toán mã hoá đảm bảo thư gửi đi khó bị giải mã. 
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IV.  Thực hành thư điện tử 

 
1. Sử dụng phần mềm Outlook Express 

1.1 Mở chương trình Outlook Express 
 

 

 

 

 
 

Nếu đây là lần đầu tiên mở chương trình này hoặc các thiết lập cho kết nối đã bị xoá thì bạn 

phải đọc đến phần * Tạo kết nối mới đến Mail Server 
 

Nếu chương trình đã tạo kết nối thì cửa sổ chương trình xuất hiện như dưới đây: 
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Giải thích các thành phần cửa sổ: 
 

(1) Thanh tiêu đề cửa sổ nằm phía trên cùng 
 

(2) Thanh thực đơn lệnh của cửa sổ 
 

(3) Thanh công cụ cung cấp các nút bấm nhanh 
 

(4) Vùng làm việc 
 

Thanh Outlook gồm các nút bấm nhanh đến các thư mục thư: Inbox, Outbox,... 

Vùng Folders: chứa các thư mục gồm 

Inbox : thư mục chứa thư được gửi đến 

Outbox : thư mục chứa thư đã soạn nhưng chưa gửi đi. Các thư này sẽ được gửi đi khi 

bạn chọn chức năng Send All. 

Sent Items: thư mục chứa nội dung các thư đã gửi đi 

Deleted Items: thư mục chứa nội dung các thư bạn xoá bỏ từ thư mục INBOX 

Drafts : thư mục tạm thời chứa các thư đang soạn. 

Vùng Contacts cho phép lưu địa chỉ thư, tạo nhóm địa chỉ 

Vùng tiêu đề thư: cho phép di chuyển nhanh giữa các thư, thao tác nhanh với thư như sao 

chép, thay đổi thuộc tính, xóa thư,... 

Vùng hiển thị nội dung thư: hiển thị ngay nội dung của thư được chọn. 
 

1.2 Đóng chương trình Outlook 
 

Nhấn nút biểu tượng Close ở góc trên bên phải của màn hình Outlook hoặc nhấn chọn thực 

đơn File->chọn Exit. 
 

1.3 Tạo kết nối mới đến Mail Server 
 

Nếu chương trình chưa cài đặt kết nối với Mail Server thì chúng ta phải thực hiện việc kết nối 

theo tuần tự các hộp thoại sau: 
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Chọn nút Next sau khi điền tên giao dịch của bạn với người khác, tên này cho phép tự đặt. 
 

 
 

Trong hộp thoại mới hiện ra, tại mục địa chỉ Email chúng ta nhập địa chỉ do nhà cung cấp 

dịch vụ qui định. 
 

Ví dụ: lab101@iti.edu.vn 
 

Địa chỉ này luôn có khuôn dạng <tên đăng ký> @ <tên miền>.  Chọn nút Next sau khi đã 

khai báo xong. 
 

 
 

Việc khai báo địa chỉ hai máy chủ phục vụ thư điện tử trên phải do nhà cung cấp dịch vụ qui 

định. 
 

Ví dụ: Bạn hãy nhập địa chỉ như hình vẽ là 10.6.200.200 trong cả hai hộp nhập. 
 

Chọn nút Next sau khi điền xong và hộp thoại mới hiện ra để bạn nhập tên đăng ký và mật 

khẩu. 

địa chỉ máy chủ 

nhận thư 

địa chỉ máy chủ 

phân phát thư 

nhấn nút Next sau khi 

đã điền xong 

mailto:lab101@iti.edu.vn
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Người hướng dẫn sẽ cấp cho bạn tên đăng ký và mật khẩu (riêng cho từng máy thực hành). 

Cuối cùng hộp thoại có lời chúc mừng bạn xuất hiện. 
 

1.4 Tạo thêm/sửa chữa/xoá bỏ các kết nối đã có với Mail Server 
 

Bước 1: Chọn mục Tools trên thanh lệnh, sau đó chọn Accounts 
 

 
 

Bước 2: Trong hộp thoại Internet Accounts, chọn trang Mail. Sau đó bấm chọn nút Add--> 

Mail. Việc này nhằm thiết lập kết nối mới để gửi và nhận thư giữa chương trình nhận thư của 

bạn với Mail Server theo một tên đăng ký sử dụng mới (ví dụ tên đăng ký sử dụng mới là 

lab101 và mật khẩu được cấp là lab101). Các bước tiếp theo đã được trình bày ở phần trên (* 

Tạo kết nối mới đến Mail Server) hoặc bấm chọn Remove để xoá bỏ một kết nối đã có, 

hoặc bấm chọn Propeties để sửa chữa một kết nối đã có. 
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1.5 Tối ưu hoá giao diện 
 

Nhấn chọn thực đơn View, chọn chức năng Layout. Trong cửa sổ WINDOW LAYOUT 

PROPERTIES có thể thay đổi các thành phần hiển thị trên cửa sổ như: 
 

+ Vùng Contacts, vùng thư mục hoặc các thanh công cụ như Outlook, Folder,... 
 

 
 

1.6 Soạn thảo và gửi thư điện tử 
 

Bước 1: Để soạn thư, nhấn nút New Mail trên thanh công cụ. Cửa sổ soạn thư xuất hiện 
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Muốn hiện mục Bcc thì bạn hãy vào mục View --> All heades 
 

Bước 2: Để gửi thư sau khi soạn xong, hãy bấm chọn nút SEND. Nếu sau khi bạn soạn xong 

nội dung hoặc đang soạn dang dở và bạn muốn cất nội dung đó (không gửi đi ngay) thì bạn 

hãy chọn thực đơn File --> Save để cất nội dung thư đang soạn vào thư mục DRAFTS. Bạn có 

thể mở lại nội dung để sửa chữa và gửi đi bất cứ lúc nào bạn muốn. Nếu bạn vào mục FILE -- 

-> chọn SEND LATER thì bức thư sẽ được lưu vào thư mục OUTBOX và sẽ được gửi đi khi 

bạn chọn chức năng SEND. 

Các thao tác khi soạn thư: 

- Có thể sử dụng các chức năng hỗ trợ của cửa sổ soạn thư để chọn phông chữ, cỡ chữ, định 

dạng in đậm, in nghiêng,... 

- Sử dụng các nút Copy, Cut, Paste trên thanh công cụ để thao tác sao chép, di chuyển nội 

dung thư. 

- bấm nút Priority để thiết lập dấu hiệu quyền ưu tiên (Priority) của bức thư. 
 

 
 

1.7 Nhận thư 
 

Bạn có thể chọn lựa các mục như hình vẽ dưới 
 

 

các địa chỉ 

được cách

nhau bằng dấu 

phẩy hoặc dấu 

chấm phẩy 
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- Nhấn nút Send/Recv: thực hiện việc vừa gửi thư trong hộp Outbox đi, vừa nhận thư mới từ 

trên máy phục vụ thư về hộp Inbox. 

 

- Nhấn nút Receive all: chỉ thực hiện việc nhận thư. 

 

- Nhấn nút Send all: chỉ thực hiện việc gửi thư. 

 
1.8 Các biểu tượng trạng thái thư 

 

Outlook hiển thị các biểu tượng phía bên trái các thông điệp để chỉ ra trạng thái các thông 

điệp đó: 

                Thông điệp chưa được đọc 

              Thông điệp có file gắn kèm 

             Thông điệp đã được đọc 

                  Thông điệp có tầm quan trọng cao 

            Thông điệp đã được trả lời 

                 Thông điệp không quan trọng 

              Thông điệp xác nhận đã đọc 

             Thông điệp đã được đánh dấu 

1.9 Đọc thư 
 

Đơn giản là bạn mở thư mục INBOX, sau đó nhấn đúp chuột lên dòng tiêu đề thư mà bạn cần 

đọc. Lưu ý đến thông báo số thư mới đến được thể hiện bằng con số cạnh tên thư mục 

INBOX. Theo hình dưới bạn có 12 thư chưa được đọc, có 1 thư chứa tệp tin đính kèm. 
 

 
 

1.10 Mở hoặc lưu một tệp đính kèm vào ổ cứng 
 

Mở một tệp đính kèm 
 

Chọn thư mục Inbox, nhấn chọn thư chứa tệp đính kèm làm xuất hiện nội dung thư. Trong 

vùng nội dung nhấn đúp vào biểu tượng tệp đính kèm. Outlook sẽ khởi động ứng dụng phù 

hợp để chạy tệp đó. Như hình minh họa là tệp Image1.jpg. 
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hoặc mở cửa sổ thư, sau đó nhấn đúp lên biểu thư tệp đính kèm trong mục Attach. 
 

 
 

 

Lưu một tệp đính kèm lên ổ đĩa cứng 

 Chọn thư mục Inbox, nhấn chọn thư chứa tệp đính kèm làm xuất hiện nội dung thư. 

 Nhấn chọn thực đơn File-> Save Attachments. Nếu thông điệp có nhiều hơn một tệp 

đính kèm hộp thoại Save Attachments sẽ xuất hiện cho phép bạn chọn những tệp 

muốn lưu lại. Sau khi chọn xong nhấn nút Save. 

 
 

 Nút Select All cho phép chọn tất cả. Ngoài ra có thể chọn tệp để lưu. 

 Nút Close dùng để đóng hộp thoại Save Attachments. 
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1.11 Chức năng trả lời thư và chuyển tiếp thư 
 

 

 

 

 

 

 

 

 

 

chọn nú 

để chuy 

này  đế 

chọn nút Reply thư 

khác 

hoặc Reply All để 

trả lời thư 
 

 

 

 

 

- nhấn nút Reply để trả lời cho 1 địa chỉ - đó là địa chỉ của người gửi thư đến. 
 

- nhấn nút Reply All để trả lời cho tất cả địa chỉ có mặt trong mục From và Cc. 
 

- nhấn nút Forward để chuyển tiếp thư đã đọc cho địa chỉ khác. 
 

1.12 Chức năng đính kèm tệp 
 

Chức năng này cho phép bạn gửi kèm theo thư các tệp văn bản hoặc tệp chương trình đến 

người nhận. 
 

Bạn hãy mở cửa sổ để viết thư. Sau khi viết xong thư, bạn nhấn nút Attach trên thanh công cụ 

(hoặc trong thực đơn Insert -> File Attachments). Sau đó chọn tệp cần đính kèm. 
 

 

chọn nút attach để 

sử dụng chức năng 

đính kèm tệp 
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1.13 Xoá tệp gắn kèm 
 

Sau khi soạn thảo thư và thao tác đính kèm tệp theo thư, chúng ta hoàn toàn có thể gỡ bỏ các 

tệp đính kèm. 
 

 Nhấn chọn tệp mà bạn muốn xoá. 

 Nhấn phím phải chuột lên tệp làm xuất hiện hộp lệnh. Chọn lệnh Remove. 

 
 

1.14 In nội dung thư 
 

 Nếu cần thiết, mở thư mục Inbox 

 Nhấn đúp vào thông điệp mà bạn muốn in để mở cửa sổ đọc thư. 

 Nhấn chuột vào biểu tượng Print trên thanh công cụ. 

 
 

1.15 Xoá thư 
 

 Mở thư mục Inbox 

 Trong vùng tiêu đề, chọn thư mà bạn muốn xoá, nhấn nút Delete trên thanh công cụ 

hoặc chọn trên thực đơn Edit -> Delete. 

 

 

Chú ý: một thư bị xoá bằng phương pháp này sẽ không bị xóa khỏi hệ thống, nó chỉ bị 

đưa tới thư mục Delete Items 
 

1.16 Làm rỗng thư mục Deleted Items 
 

 Mở thư mục Deleted Items 

 Nhấn chọn thực đơn Edit-> Empty ‘Deleted Items’ Folder. Hộp thoại dưới đây sẽ hiện 

ra 
 

 

 

 

 Để xoá nội dung thư mục Deleted Items, hãy kích vào nút Yes hoặc nhấn Enter 
 

1.17 Ghi vào sổ địa chỉ 
 

Bạn có thể ghi địa chỉ của bạn bè, khách hàng vào trong một danh sách -gọi là sổ địa chỉ và sử 

dụng sổ này để điền vào mẫu soạn thư một cách nhanh chóng và chính xác. 
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Cách thêm từng địa chỉ vào sổ: 
 

Trong cửa sổ chính bấm vào nút Contacts --> New Contact... Sau đó nhập các mục yêu cầu. 
 

 
 

 

 

Cách thêm địa chỉ vào sổ theo địa chỉ có trong thư gửi đến: 
 

Bước 1: Mở thư đã nhận được 

Bước 2: Vào mục Tool --> Add to Address Book --> Sender 
 

 
 

1.18 Thao tác với vùng tiêu đề thư 
 

Vùng tiêu đề thư có những cột dữ liệu thông báo về trạng thái thư như cột From, Subject,... 
 

 
 

Chúng ta có thể thực hiện các thao tác sau: 
 

(1) Hiển thị/che dấu các cột dữ liệu 
 

Để làm việc này, nhấn chọn thực đơn View -> Columns hoặc nhấn nút phải lên các cột dữ liệu 

trong vùng tiêu đề thư. 

chọn nút Contacts 

để thêm từng địa chỉ 
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Trong hộp thoại xuất hiện nhấn chọn hoặc xóa chọn các cột có trong danh sách. Có thể sử 

dụng các nút như Hide/Show có chức năng tương tự. 
 

 
 

- Nút Move Up/Move Down cho phép thay đổi thứ tự sắp xếp các cột. 

- Nút Reset cho phép đặt lại trạng thái đầu tiên của chương trình khi mới cài đặt. Nhấn nút 

OK để kết thúc hoặc nhấn nút Cancel để hủy bỏ thay đổi và đóng hộp thoại. 

(2) sắp xếp các tiêu đề thư theo các cột bằng cách nhấn chuột vào các nút biểu diễn cột. Ví dụ 

muốn sắp xếp tiêu đề thư theo cột From (tên người gửi), Subject (chủ đề), Received (ngày 

nhận),... 

(3) đặt thuộc tính cho thư 

Nhấn nút phải trên tiêu đề thư làm xuất hiện hộp thoại 
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- lệnh Open là để mở thư 

- lệnh Print là để in thư 

- lệnh Reply to Sender là để gửi trả lời thư, Reply All là để trả lời cho nhiều địa chỉ có ghi 

trong thư. 

- lệnh Forward là để chuyển tiếp thư 

- lệnh Mark as Read để chuyển thư sang thuộc tính đã được đọc 

- lệnh Mark as Unread để chuyển thư sang thuộc tính chưa được đọc 

- lệnh Move to Folder để di chuyển thư đến các thư mục khác. Ví dụ từ trong thư mục Deleted 

Items có thể chuyển về lại thư mục Inbox. 

- lệnh Copy to Folder để sao chép thư. 

- lệnh Delete là để xóa thư vào thư mục Deleted Items 

- lệnh Add Sender to Address Book là để ghi địa chỉ người gửi vào sổ địa chỉ. 

- lệnh Properties cho hiển thị các thông tin về thư. Ví dụ thư từ địa chỉ nào gửi đến,... 

(4) Thiết lập trạng thái cờ (Flag) cho thư 

Để đặt cờ cho thư   

 Nhấn chọn thư trong vùng tiêu đề. 

 Nhấn chọn thực đơn Message-> Flag Message hoặc nhấn chuột một lần vào vùng 

trống của cột cờ dành cho thư làm xuất hiện biểu tượng   
 

 Sau khi đặt cờ cho các thư, chúng ta có thể thực hiện tiện ích sắp xếp thư theo trạng 

thái có đặt cờ. 

 

Để gỡ bỏ cờ đánh dấu khỏi một thông điệp 

 Nhấn chọn thư trong vùng tiêu đề. 

 Nhấn chọn thực đơn Message-> Flag Message hoặc nhấn chuột một lần vào biểu 

tượng cờ đã có để làm mất biểu tượng. 
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1.19 Kiểm tra lỗi chính tả của thư tiếng Anh 
 

 Trong cửa sổ soạn thư nhấn chọn thực đơn Tools->Spelling hoặc nhấn nút Spelling 

trên thanh công cụ. 

 
 

Từ sai chính tả sẽ được hiển  thị  trong hộp  văn bản Not in Dictionary. Danh sách 

Suggestions hiển thị những gợi ý sửa lỗi. Chọn từ gợi ý trong danh sách của Suggestions 

hoặc gõ một từ vào hộp văn bản Change to 

- Nút Ignore: Bỏ qua từ trong hộp văn bản Not in Dictionary 

- Nút Ignore All: Bỏ qua mọi từ trong hộp văn bản Not in Dictionary 

- Nút Change: Thay thế từ mắc lỗi chính tả bằng từ trong hộp văn bản Change 

- Nút Change All: Thay thế từ mọi mắc lỗi chính tả bằng từ trong hộp văn bản 

Change 

- Nút Add: Thêm từ trong hộp văn bản Not in Dictionary vào trong từ điển 

Khi quá trình kiểm tra chính tả hoàn tất, hộp thoại dưới đây sẽ hiện ra. Kích vào nút OK 

hoặc nhấn Enter để thoát ra. 
 

 

 
 

 

1.20 Tìm kiếm thư 
 

 Mở thư mục Inbox 

 Nhấn chọn thực đơn Edit->Find hoặc nhấn nút Find trên thanh công cụ. 
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 Nhập từ tìm kiếm và nhấn nút Find Now. Outlook sẽ thực hiện tìm kiếm và liệt kê các 

thư phù hợp với điều kiện. Nhấn đúp vào tiêu đề thư để mở nội dung của nó. 
 

1.21 Tạo một thư mục email mới 
 

 Mở thư mục Inbox 

 Nhấn chọn thực đơn File-> Folder ->New làm xuất hiện hộp thoại 

 

 
Nhập tên thư mục mới vào ô Folder name. Nhấn nút OK để kết thúc. 

 

1.22 Di chuyển thư tới một thư mục mới 
 

Để di chuyển một thư tới một thư mục khác 
 

 Mở thư mục Inbox 

 Chọn thư mà bạn muốn di chuyển bằng cách nhấn chọn trong vùng tiêu đề thư 

 Nhấn chuột phải vào vùng chọn làm xuất hiện họp lệnh. 

 Chọn lệnh Move to Folder 
 

1.23 Sử dụng sổ địa chỉ 
 

Khi soạn thư mới: 

 

Bạn chỉ cần bấm chọn địa chỉ có sẵn trong cửa sổ Contacts để mở cửa sổ soạn thảo thư có sẵn 

dòng địa chỉ mà không cần gõ lại bằng tay. 
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Ngoài ra có thể thao tác ngay trong cửa sổ soạn thư bằng cách bấm vào nút TO để mở hộp 

thọai cho phép chọn địa chỉ đã có. 
 

 
 

Tạo địa chỉ nhóm thư 
 

Địa chỉ nhóm thư là một địa chỉ đại diện cho nhiều địa chỉ khác. Khi gửi thư theo địa chỉ 

nhóm thư đồng nghĩa với việc gửi thư đến tất cả địa chỉ trong nhóm. Điều đó cho phép một 

nhóm người trao đổi thư với nhau rất tiện lợi. Cách tạo địa chỉ nhóm thư: 
 

Bước 1: Tại cửa sổ chính vào mục Tools --> Address Book... (hoặc bấm tổ hợp phím CTRL- 

SHIFT-B). 
 

Bước 2: Trong cửa sổ Address Book, bấm chọn nút New--> New Group 

chỉ  cần  bấm  chọn 

địa chỉ người gửi 

bấm chọn địa chỉ 

người gửi rồi bấm

nút TO hay CC 
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Bước 3: Trong cửa sổ Properties, gõ tên trong phần Group Name. Sau đó chọn nút Select 

Members để nhập các địa chỉ của cùng một nhóm. Theo cách này một địa chỉ Email có thể 

thuộc nhiều nhóm thư khác nhau. Địa chỉ nhóm thư được sử dụng như một địa chỉ thư bình 

thường, ví dụ banbe@vnu.edu.vn - với banbe là địa chỉ nhóm thư. 
 

 
 

Bước 4: Thực hiện gửi thư theo địa chỉ nhóm đã tạo. 

 



2. Sử dụng dịch vụ thư điện tử YAHOO MAIL 

Mở trình duyệt WEB và nhập địa chỉ MAIL.YAHOO.COM vào ô địa chỉ để mở trang WEB 

có dịch vụ thư điện tử miễn phí Yahoo Mail. 
 

Nếu bạn đã có tài khoản sử dụng thì hãy nhập tên và mật khẩu vào các hộp, sau đó nhấn nút 

đăng nhập (có tên là Sign In). 

mailto:banbe@vnu.edu.vn
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Chương trình Yahoo Mail sẽ kiểm tra tính hợp lệ của các nội dung nhập để bắt nhập lại hoặc 

cung cấp chương trình đến máy người dùng cho phép thao tác với thư. 

 

 
 

Nếu bạn là người lần đầu tiên sử dụng dịch vụ này hoặc bạn muốn tạo cho mình một hộp thư 

thư mới thì hãy làm phần đăng ký tên sử dụng. 
 

 

 

 

 

 

2.1 Đăng ký hộp thư miễn phí trên YAHOO 
 

Một người có thể đăng ký cho mình nhiều hộp thư điện tử miễn phí. Mỗi hộp thư đòi hỏi có 

một tài khoản sử dụng gồm tên định danh và mật khẩu. 

nhập tên đã đăng 

ký vào đây 

nhập mật khẩu 

vào đây 
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Trên màn hình sẽ xuất hiện trang khai báo 

 

 

nhấn chuột vào nút

Sign Up Now để 

thực hiện đăng ký 

nhấn chuột vào

nút Sign Up For 
Yahoo! Mail 

trong phần Free 
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Bảng 1- đăng ký sử dụng dịch vụ 

Hướng dẫn điền thông tin vào bảng 1: 

o Tại hộp First Name - nhập khai báo về họ và hộp Last Name - nhập khai báo 

phần còn lại của tên. Trong phần này có thể gõ khoảng trống và gõ được tiếng 

Việt theo bảng mã Unicode nhưng bạn không nên gõ tiếng Việt vì chương trình 

Yahoo Mail không hiển thị đúng tiếng Việt nên làm cho tên của bạn không 

hiện đúng nội dung như hình dưới đây. 
 

 

o Tại hộp Yahoo! ID cần điền tên định danh (ví dụ: nguyenthuanhai, sau này 

bạn sẽ có địa chỉ thư như sau: nguyenthuanhai@yahoo.com). Việc đặt tên định 

danh cần có lưu ý sau: 

 tên định danh chỉ gồm các ký tự chữ cái, chữ số và dấu gạch dưới (_), 

không gõ tiếng Việt cho tên định danh. 

 tên định danh như là tên tài khoản tại ngân hàng, mang tính duy nhất 

đối với hệ thống nên việc đặt tên không phải lúc nào cũng được chấp 

nhận. Ví dụ theo bảng 1, sau khi đặt tên định danh là nguyenthuanhai, 

nhấn chọn mục Check if this ID is available (có nghĩa là kiểm tra xem 

tên này có hợp lệ không) hộp thoại sau đây xuất hiện thông báo tên 

không hợp lệ. 
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Đóng hộp thoại trở về lại bảng khai báo và đổi tên định danh là 

ngthuanhai và nhấn chọn mục Check if this ID is available một lần 

nữa, hộp thoại sau xuất hiện thông báo tên hợp lệ. Đóng hộp thoại trở 

về bảng 1 để tiếp tục phần đăng ký. 
 

 

o Hộp PASSWORD và RE-TYPE PASSWORD đòi hỏi bạn nhập mật khẩu. Để 

đảm bảo bí mật nên gõ mật khẩu từ 6 kí tự trở lên gồm chữ cái hoặc chữ số. 

Một lỗi thường gặp khi nhập mật khẩu đó là: 

 bộ gõ tiếng Việt đang bật làm thay đổi nội dung của mật khẩu. Ví dụ 

chúng ta gõ vào chữ haisan nhưng bị đổi thành háian. Khi gõ mật khẩu 

chúng ta chỉ thấy các dấu * nên không phát hiện được lỗi này. Đề nghị 

đóng chương trình bộ gõ tiếng Việt trước khi nhập mật khẩu. 

 các ký tự chữ cái nhập vào có phân biệt chữ hoa và chữ thường nên 

chúng ta phải kiểm tra cẩn thận nội dung bằng cách mở chương trình 

NotePad gõ kiểm tra nội dung trước. 

o Chọn một câu hỏi cho hộp SECURITY QUESTION (câu hỏi bảo vệ) bằng 

cách nhấn mũi tên bên phải của hộp (ví dụ chọn câu đơn giản như What was 

the name of your first school?). 

o Trong phần YOUR ANSWER bạn có thể gõ: HANOI 

o Chọn ngày sinh cho hộp BIRTHDAY (ví dụ chọn July) sau đó gõ số vào ô 

tháng và năm 

Các thông tin gồm câu hỏi bảo vệ, câu trả lời, ngày tháng năm sinh cần được lưu 

lại cẩn thận đề phòng trường hợp bạn quên mật khẩu thì Yahoo cho phép bạn lấy 

lại mật khẩu qua việc nhập đúng và đầy đủ thông tin. 

o Bạn có thể bỏ qua phần hỏi CURRENT EMAIL (vì có dòng chữ Optional) 
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Trong bảng 2, 

Bảng 2 - đăng ký sử dụng dịch vụ 

o Tại hộp LANGUAGE&CONTENT hãy giữ nguyên mục đã có là English - 

United States. 

o Tại hộp ZIP/POSTATL CODE (mã số bưu điện) hãy gõ vào số 84093 - một 

mã số bưu điện của Mỹ 

o Chọn Male (nam) hay Female (nữ) cho hộp GENDER (giới tính) 

o Phải chọn nghề nghiệp và lãnh vực công tác trong hộp OCCUPATION và 

INDUSTRY. Nếu bạn bỏ qua mục này bạn sẽ gặp trang thông báo lỗi. 

o Gõ chữ xuất hiện trong hình chữ nhật (ví dụ trên là 56wzK3) vào hộp trống. 

Nội dung của chữ xuất hiện là ngẫu nhiên đối với mỗi lần đăng ký. Sau đó 

chọn nút SUBMIT THIS FORM để đăng ký phần vừa khai báo xong. 

o Trang WEB chào mừng việc đăng ký thành công như sau (nếu bạn không bị lỗi 

trong phần khai báo) 
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Trong màn hình chúc mừng có các thông báo quan trọng mà chúng ta phải ghi lại đó là: 
 

* tên định danh (Yahoo! ID) 
 

* mật khẩu không được nhắc đến nhưng chúng ta phải nhớ lại chính xác mật khẩu mà 

chúng ta đã nhập trong bảng đăng ký. Tên định danh và mật khẩu cần phải được nhập 

chính xác khi đăng nhập sử dụng dịch vụ. 
 

* địa chỉ Email đầy đủ được cung cấp theo dạng: <tên định danh>@yahoo.com 
 

Chú ý: Bỏ chọn của ô Install Yahoo! để quá trình hoàn tất đăng ký được nhanh chóng. 
 

 
 

Nhấn nút CONTINUE TO YAHOO! MAIL để hoàn tất việc đăng ký và bắt đầu sử dụng 

chương trình gửi và nhận thư. 
 

2.2 Sửa lỗi khi đăng ký 
 

Không phải khi nào bạn cũng có được ngay khai báo đúng nên phải tập làm quen với việc sửa 

lỗi với các thông báo bằng tiếng Anh. 
 

Dòng thông báo khi tên đăng ký của bạn không hợp lệ (do đã trùng với một tên đã có) 
 

 
 

Các dòng nhãn ô được in màu đỏ báo hiệu lỗi khi khai báo, Bạn phải nhập lại các nội dung 

cho đúng với yêu cầu. 
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Bạn phải nhập lại dòng chữ ngẫu nhiên xuất hiện vào ô trống. 

 

 
 

sau khi nhập xong tiếp tục bấm nút SUBMIT THIS FORM. 
 

2.3 Làm quen cửa sổ chương trình thư 
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Các mục xuất hiện trên màn hình cần quan tâm gồm: 
 

- Nút Check mail (kiểm thư) thực hiện kiểm tra và hiển thị hộp thư Inbox. 

- Nút Compose để mở cửa sổ soạn thư. 

- Nút Search Mail để tìm thư theo yêu cầu 

- Các thư mục gồm: Inbox (chứa thư đến), Draft (chứa thư nháp), Sent(chứa bản lưu cho các 

thư đã gửi),Trash (chứa các thư bị xoá). 

- Hộp lệnh Addresses cho phép tổ chức lưu giữ các địa chỉ 
 

 
 

 

- Mục Mail Options : chứa nhiều tiện ích trong đó có chức năng cho phép thay đổi mật khẩu 
 

 
 

 

 

 

Mail Options 

có chứa mục

thay đổi mật

khẩu 

Nhấn 

vào mục 

Account 

Information 

để mật

khẩu 
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2.4 Đóng/ mở hộp thư 
 

Chọn mục Sign Out để đóng hộp thư, trở về cửa sổ đầu tiên của chương trình thư. 
 

 
 

Trên cửa sổ đầu tiên nhập tài khoản đã đăng ký phải lưu ý đến bộ gõ tiếng Việt. Khi nhập mật 

khẩu, phải tắt chức năng gõ tiếng Việt để nhập chính xác. 
 

 
 

2.5 Mở hộp thư 
 

Nhấn chọn mục Check mail hay mục Inbox để mở hộp thư. 
 

 
 

 

Trong hình vẽ minh họa hiển thị Inbox(1) nghĩa là đang có 01 thư chưa đọc. 
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Nhấn chuột vào mục chủ đề (Subject) bức thư để mở thư. Trong cửa sổ hiện nội dung bức 

thư, bạn có thể sử dụng các chức năng Reply để trả lời thư cho người gửi, Reply All để trả lời 

thư cho tất cả địa chỉ thư có trong bức thư nhận được hoặc Forward là chuyển tiếp nội dung 

thư nhận được đến cho địa chỉ khác. 
 

 
 

2.6 Xoá bớt thư 
 

Bấm chọn một hoặc nhiều thư muốn xoá, sau đó nhấn nút DELETE. 
 

 
 

Chú ý là bạn có thể chọn nhiều thư để xoá cùng một lần. Có mục Check all giúp bạn chọn tất 

cả các thư một lúc một cách nhanh nhất và sau đó chỉ cần chọn nút Delete. 

Khi đã chọn thư có thể xóa chọn bằng cách nhấn chuột vào ô chọn làm mất dấu chọn hoặc 

nhấn chọn mục Clear All 
 

2.7 Soạn thư 
 

Nhấn vào nút COMPOSE để mở cửa sổ soạn thư như sau 
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Trong ô địa chỉ người nhận (To) có thể nhập nhiều địa chỉ, các địa chỉ cách nhau bằng dấu 

phẩy. 
 

Trong nội dung thư có thể đặt định dạng như in đậm, in nghiêng,... và có thể chèn thêm các 

biểu tượng sinh động biểu thị trạng thái. 
 

2.8 Ghi địa chỉ vào sổ 
 

 
 

Chương trình thư của Yahoo có hổ trợ sổ lưu địa chỉ thư rất tiện dụng. Chúng ta làm quen với 

các khái niệm sau: 
 

Contact Address : địa chỉ người cần liên lạc. 
 

Category name : danh mục tên. 
 

Address List : tên nhóm địa chỉ. Các địa chỉ người gửi được ghi nhận theo 

nhóm và tên nhóm sẽ đại diện cho tất cả các địa chỉ trong nhóm khi chúng ta chọn địa 

chỉ gửi thư. Tiện ích này giúp cho người gửi xác định địa chỉ gửi thư nhanh chóng, 

chính xác. 

lưu các  thư tạm

thời chưa gửi nút

gửi thư 

chức năng 

đính kèm tệp 

chọn chức năng 

Addresses 
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Cách thêm một địa chỉ vào sổ 
 

Bấm chọn mục Addresses để mở cửa sổ như hình minh họa dưới đây. 
 

 
 

+ Bấm nút Add Contact để ghi địa chỉ liên lạc vào sổ theo các thông tin nhận được qua 

giao tiếp, ví dụ sau khi nhận được danh thiếp cá nhân. 
 

 
 

Bấm nút Save sau khi hoàn thành xong việc điền thông tin. 
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+ Bấm chọn mục Add List để tạo địa chỉ nhóm. 
 

 
 

Nhấn nút Save để hòan tất việc tạo địa chỉ nhóm. 
 

Nếu người sử dụng đang mở thư để đọc thì cách nhanh nhất để ghi địa chỉ vào sổ là nhấn 

chuột vào mục Add to Adress Book đang có trên màn hình. 
 

 
 

2.9 Sử dụng sổ địa chỉ 
 

Với sổ địa chỉ ngoài việc chúng ta xem lại các thông tin đã ghi, chúng ta còn có thể dễ dàng 

chèn địa chỉ từ sổ địa chỉ vào các ô To, Cc, Bcc... như sau: 

nhập chỉ 

nhóm 

chọn địa chỉ  nhóm

và nhấn nút Add 

bấm chọn mục 

này để ghi địa chỉ 

người gửi vào sổ 

ngay sau khi đọc

thư 
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Mở cửa sổ viết thư, sau đó nhấn chuột vào mục Insert address hoặc mục To hoặc Cc làm xuất 

hiện hộp thoại địa chỉ thư. 
 

Trong hộp thoại Address Book cho phép chúng ta chọn lựa các địa chỉ cho từng mục To, Cc, 

Bcc. Kết thúc việc chọn bằng cách nhấn Insert Checked Contacts. 
 

 
 

2.10 Sử dụng chức năng đính kèm tệp 
 

Đính kèm tệp là một chức năng vô cùng quan trọng trong việc gửi thư điện tử. Bạn có thể gửi 

tối đa là 03 thư và kích thước tổng cộng không quá 1.5MB khi dùng chức năng miễn phí này 

của MAIL.YAHOO.COM. 
 

Bạn phải thực hiện ba bước để xác định các tệp đính kèm như hình dưới 
 

Bước 1: Sau khi soạn thư, nhấn vào nút Attach Files làm xuất hiện hộp thoại điều khiển các 

bước đính kèm tệp. 
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Bước 2: Trong hộp thoại điều khiển cần đính kèm hiện ra 
 

 
 

YAHOO hỗ trợ tối đa năm tệp đính kèm, với tổng dung lượng tối đa là 10MB. Nhấn nút 

Browse… rồi lựa chọn tập tin cần đính kèm trong cửa sổ Choose File. 
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Sau khi chọn tệp, nhấn nút Open để đồng ý hoặc nhấn nút Cancel nếu không đồng ý và quay 

trở về cửa sổ chọn tệp. Bấm nút Attach Files để hoàn thành việc đính kèm. Màn hình 

Attaching Files hiện ra thông báo yêu cầu người dùng chờ trong giây lát. Thời gian chờ phụ 

thuộc vào tốc độ đường truyền Internet. 
 

 
 

Bước 3: Nếu không có gì sai sót thì màn hình Attachments hiện ra thông báo “Đã đính kèm 

các tệp được liệt kê vào thư". Trong hình dưới, tệp tin có kích thước 42k đã được đính kèm. 
 

 
 

Nhấn nút Done để kết thúc thao tác đính kèm và quay trở về màn hình soạn thảo thư. 
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Sau khi thực hiện thành công ba bước trên bạn sẽ thấy cửa sổ soạn thư xuất hiện cùng với 

danh sách các tệp đính kèm. 
 

 
 

Nhấn nút Remove nếu muốn gỡ bỏ tệp đính kèm. Nhấn nút Send để gửi thư. 
 

2.11 Mở tệp đính kèm theo thư 
 

Việc mở tệp đính kèm theo thư có hai lựa chọn: 

(1) lấy tệp về máy tính trước khi xem. 

(2) mở ngay tệp đính kèm để xem. 

Nên chọn cách thứ (1) vì việc lấy tệp về máy tính sẽ đảm bảo tệp được nằm sẵn sàng trên máy 

tính trong lúc đọc nên không phải lo ngại về tốc độ đường truyền Internet. 
 

 

dấu hiệu của thư 

có tệp đính kèm 

bấm vào mục để 

xem ngay không 

cần lấy về máy 

tính 

bấm vào mục này

để lấy tệp về máy 

tính trước khi xem 


